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Overview 

Task Objectives 

The objective of fluid lubrication is to penetrate into the contact area between solid objects, 

which generate friction, and to form a thin oil film to reduce abrasion and frictional heat 

caused by friction. This oil film separates two solid surfaces from directly contacting each 

other and reduces friction and heat between them to smooth their movement.  

The history of the lubrication theory started with an equation derived from the fluid flow 

existing in the narrow gap between two solid objects. The equation was presented by O. 

Reynolds back in 1886. This equation, called the Reynolds equation named after him, 

established the basis of the lubrication theory.  

In this tutorial, EHD (elastic, hydraulic, and dynamic) elements, which are developed based 

on the Reynolds equation, are used to model the lubrication action at the part where the 

cylinder and the piston in the engine system contact each other and to perform the dynamic 

analysis of the cylinder and the piston considering their lubrication characteristics. 

▪ Configure the piston lubrication using the rigid model. 

▪ Swap the rigid bodies with the RFlex bodies, perform the analysis of the piston lubrication, 

and check the result of the lubrication action.  
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Prerequisites 

This tutorial is intended for users who have completed the basic tutorials provided with 

RecurDyn. If you have not completed these tutorials, then you should complete them before 

proceeding with this tutorial.  

Task 

This tutorial consists of the following tasks and the time required for each task is listed in the 

table below. 

 

Procedures  Time (minutes) 

Opening the initial Model 10 

Analyzing Piston Lubrication with Rigid Bodies 30 

Analyzing Piston Lubrication with RFlex Bodies 30 

Analyzing the Results 10 

Modifying Piston Profile and Analyzing Piston 

Lubrication 

10 

Total 90 

 

Estimated Time to Complete this Task 

90 minutes 
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Opening the Initial Model 

Task Objectives 

To open and observe the initial model. 

 

Estimated Time to Complete This Task  

10 minutes 

  

Chapter 
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Opening the RecurDyn Model 

To run RecurDyn and open the initial model 

1. On the Desktop, double-click the RecurDyn icon to open RecurDyn. 

2. When the Start RecurDyn dialog window appears, close it. 

3. In the File menu, click Open. 

4. Navigate to the tutorial folder and select PistonLubricationEHD_Start.rdyn. (File 

path: <Install Dir>\Help\Tutorial\Toolkit\EHD\PistonLubrication). 

5. Click the Open button. to open the model shown in the following figure. 

 

 

The following explains the configuration of the model. 

An engine block consists of a cylinder, a piston, a piston pin, a connecting rod and a crank. 

The piston moves via the translation force defined with the spline of gas force according to 

the crank angle. The piston and the cylinder are joined by a translation joint, which makes 

the piston only move up and down. 

 

To save the model: 

1. In the File menu, click Save As. 

(You cannot perform the simulation if the model is in the tutorial path, so you must save the 

model in a different path.) 
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Performing Simulation 

This section teaches you how to perform an initial simulation using the model in order to 

understand its behavior. 

 

To perform the initial simulation: 

1. On the Analysis tab, in the Simulation Type group, click the Dyn/Kin icon. 

2. The Dynamic/Kinematic Analysis dialog window appears. 

3. After verifying the simulation conditions, click Simulation. 

 

To view the result: 

Under the Analysis tab, in the Animation Control group, press the Play button to check if 

the connecting rod moves as shown in the figure below. 
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Analyzing Piston Lubrication 

with Rigid Bodies 

Task Objectives 

For the lubrication analysis using EHD, you should define the cylinder and the piston of the 

engine system as the piston lubrication force. In this chapter, we will keep the modeling 

elements, such as joint and force, configured in the previously opened model as is, and 

define the piston lubrication to simulate and analyze the lubrication action of the rigid bodies. 

 

Estimated Time to Complete This Task  

30 minutes 
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Creating piston lubrication 

1. From the previous model, delete TraJoint1 which was defined for movement. 

2. Under the Toolkit tab, in the Toolkit group, click the Piston Lubrication icon. 

 

3. For the Creation Method, select Body, Point, Direction, Direction, Body, Point, Direction 

and Direction. 

4. For the first body, select Cylinder, which is to be the Base Body, and click “0,-46.5,0”, 

which is the middle part of the entire cylinder. 

▪ Use the Distance Measure function to check it. 

 

5. Enter “0,1,0” for the axis on which the base body moves, and “1,0,0” for its direction of 

rotation. 

6. For the second body, select Piston, which is to be the Action Body, and click “0,-

29.5,0”, which is the middle part of the area contacting the cylinder. 

▪ From the Layer Settings window, uncheck Show All and uncheck the layer to which 

the cylinder body belongs so that you can select the piston body easily. 
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7. Enter “0,1,0” for the axis on which the action body moves, and “1,0,0” for its direction 

of rotation. You should set directions the same as those set for the cylinder body. 

8. Make sure that the forces have been created in the Database Window. 

 

Defining Piston Lubrication 

In the piston lubrication created just before, we set the default values without considering the 

actual geometry of the cylinder and the piston. Now you should set them with the values of 

the geometry again. 

 

1. Right-click Lubrication1 and select Properties in the context menu. 

2. Enter 70 in the Piston Diameter field, 29 in the Piston Height field, 70.045 in the 

Cylinder Diameter field and 95 in the Cylinder Height field. 

▪ The value of the initial gap between the cylinder and the piston is the difference 

between both diameters divided by 2. In this tutorial, it is 0.0225. 

 



P I S T O N  L U B R I C A T I O N  ( E H D )  

 

12 

 

3. Click Mesh Grid Setting to adjust the mesh size. Enter 42 in the Circumference 

Node No. field and 21 in the Axial Node No. field. 

▪ For each direction, refer to the figure at the 

right.  

 

 

▪ If the circumferential and axial directions have 

similar mesh grid sizes, you can perform the 

EHD analysis more efficiently.  

▪ In this tutorial, the sum of the circumferential length is 70.045*π = 220.05 and its 

height is 95. Therefore, if you want to use the mesh grid of the size of about 5 mm, 

the appropriate quantity in the circumferential direction is 44 and that in the axial 

direction is 19. 
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4. For the asperity contact, click Additional Options to configure additional settings. If the 

thickness of the oil film becomes less than the roughness multiplied by 4 during the 

lubrication action, the asperity contact occurs. 

5. Enter values for the parameters to calculate the asperity contact as follows: 

▪ Roughness: 0.001 

▪ Composite Elastic modulus: 68000 

▪ Elastic Factor: 0.003 

▪ Friction Coefficient: 0.5 

 

6. Click the Close button to close the window and click the OK button in the Properties 

dialog window for Lubrication1 to close it. 

 

roughness 

Friction Coeff.  
μ 

Composite Elastic Modulus 
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Performing Dynamic Analysis on Piston Lubrication and 

Checking Its Result 

To run the simulation for piston lubrication: 

1. Save the model as PistonLubricationEHD _Rigid.rdyn. 

2. On the Analysis tab, in the Simulation Type group, click the Dyn/Kin icon. 

3. The Dynamic/Kinematic Analysis dialog window appears. 

4. After verifying the simulation conditions, click Simulation. 

 

To view the result: 

1. On the Analysis tab, in the Animation Control group, click the Play button to view 

the animation. 

2. Right-click Lubrication1 and select Property in the context menu. 

3. Click Contour Setting and select Hydrodynamic + Asperity for Pressure Type. 

▪ You will be able to check the total lubrication force. 

4. Change the Maximum Value field to 1 and click the OK button to close the window. 

▪ Play the animation again to see that the maximum values appear at both sides of 

the piston. 
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5. Click the Output Data Export button in the Properties dialog window for 

Lubrication1. 

6. You can view the lubrication thickness and pressure from the top using a graph. 

a. Select Thickness. In Angle base, enter 80 in the Frame for Plotting Time field 

and 4 in the Circum. Line field. 

b. Click the View button to check Circumference Line and click the Plot button. 

c. You can see that the thickness of the oil film changes along the 4th line.  

d. Select Pressure and click the Plot button under the same state as before. 
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e. You can see that the pressure increases at the point where the oil film is thin. 
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Analyzing Piston Lubrication 

with RFlex Bodies 

Task Objectives 

In this chapter, the cylinder and the piston in the previously defined rigid model are defined 

as RFlex bodies and the piston lubrication is analyzed considering the deformation. 

 

Estimated Time to Complete This Task  

30 minutes 

 

  

Chapter 
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Creating RFlex Bodies 

1. Click the G-Manager icon in the G-Manger group under the Flexible tab. 

2. From the Working Window, select Cylinder Body to display the G-Manager dialog 

window. 

3. Select RFlex for the Target Converting Body field and set the Type field to Swap 

using RFI File. 

▪ For the purpose of this tutorial, the RFI file is provided in the <Install 

Dir>\Help\Tutorial\Toolkit\EHD folder. 

4. Set the RFI File Path field to Cylinder.rfi. 

5. Use Cylinder for the Reference field. 

6. Click the Execute button in the G-Manager dialog window. The Cylinder will be 

replaced with that of an RFlex Body as shown in the following figure.  
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7. Also, for the Piston, use the Piston.rfi file and replace the piston with that of an RFlex 

Body in the same way as above.  

 

Creating PatchSet 

1. From the Working Window, select the Cylinder Body and double-click it. 

2. When you entered the Flex Edit Mode, click the Patch Set icon in the Set group under 

the RFlex Edit tab to create a PatchSet. 

3. From the Patch Set dialog window, click 

the Add/Remove (Continuous) button 

and select one of patches placed at the 

inner side of the cylinder body. 

4. Click Finish Operation from the context 

menu that appears when you right-click, 

press the OK button to close the Patch 

Set dialog window. You will see that 

SetPatch1 is created. 

5. Click the Exit icon to return to the 

Assembly Mode, select the Piston 

Body again and double-click it. 

 

 

6. To create a PatchSet, click the Patch Set icon in the Set group under the RFlex Edit 

tab. 

7. For the Piston Body, create two patch sets, one at the top where the gas explosion 

pressure will be applied and the other for piston lubrication. 

Piston.SetPatch1 

Piston.SetPatch2 
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8. Click the Exit icon to return to the Assembly Mode. 

 

Defining Modal Pressure Load to Piston 

1. Delete Translational1 used for the rigid body model. 

2. Click the Modal Pressure Load icon in the RFlex group under the Flexible tab. 

3. For the patch set, select 

Piston.SetPatch2 (PatchSet 

at the top of the piston), 

which was previously created, 

from the Modal Pressure 

Loads dialog window. 

4. Change the Pressure 

Direction option to Down so 

that the pressure is applied to 

the piston. 

5. Click the EL button. From the 

Expression List dialog 

window, select the 

EX_Modal_Pressure field and 

set the pressure value. 
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Configuring RFlex Body PatchSets for Piston Lubrication 

1. Open the Properties dialog window for Lubrication1. 

2. Enter Patch Sets for the cylinder and the piston respectively. 
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Performing Dynamic Analysis on Piston Lubrication and 

Checking Its Result 

To reduce the number of RFlex body modes: 

10 or more modes exist for each Rflex body. To shorten the analysis time, use only 5 modes 

for each body. 

1. Right-click Cylinder Body and select 

Property in the context menu. 

2. Select the Mode option under the 

RFlex tab in the Properties dialog 

window for Cylinder Body. 

3. Select Mode Type for the Mode Range 

and click the UnSelect button to 

deselect all the modes. 

4. Enter 7 - 11, click the Select button 

and make sure that 5 consecutive 

modes are checked starting from the 

mode no. 7. 

5. Also, for the Piston Body, select only 5 

modes in the same way as above. 

 

 

 

 

 

 

 

To run the simulation for piston lubrication: 

1. Save the model as PistonLubricationEHD _RFlex.rdyn. 

2. On the Analysis tab, in the Simulation Type group, click the Dyn/Kin icon. 

3. The Dynamic/Kinematic Analysis dialog window appears. 

4. Change the End Time field to 0.03 and the Step field to 1000 and click the 

Simulation button. 

▪ It will take approximately 34 minutes for the analysis. 
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Analyzing the Results 

Task Objectives 

In this chapter, we will check the results of an analysis performed on the previously defined 

model. 

 

Estimated Time to Complete This Task  

10 minutes 

  

Chapter 
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Viewing Contour Result 

1. Uncheck the Show All option in the Layer Settings dialog window to hide the cylinder 

and display only Layer 1. 

2. Right-click Lubrication1 and select Property in the context menu. 

3. Check the Show Pressure Contour option and click the Contour Setting button. 

4. Select Hydrodynamic + Asperity for the Pressure Type field to check all the forces 

of the lubrication and click the Apply button to check the Contour. 

 

5. To view only the skirt section of the piston, enter 0.1 in the Cut Off Pressure field in 

the Contour dialog window and click the Apply button to check the Contour. 
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Viewing Plot Result 

1. Click the Plot Result icon in the Plot group under the Analysis tab. 

2. From the Plot Window, click the Show Upper Windows icon in the Windows group 

under the Home tab. 

3. In the widow at the left, click the Load Animation icon in the Animation group under 

the Tool tab. In the widow at the right, select the Force/ PistonLubrication EHD 

Force/Lubrication1/Total/FX_Total option in Plot Database to draw a plot. 
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4. Clear the plot drawn just before. From Plot Database, select the following two data 

items to draw them: 

▪ Force/PistonLubrication EHD 

Force/Lubrication1/HydroDynamicForce/POSITIVE_X/FX_Hydro 

▪ Force/PistonLubrication EHD 

Force/Lubrication1/HydroDynamicForce/NEGATIVE_X/FX_Hydro 

5. Click the Add Page icon in the Windows group under the Home tab to add a page to 

the Plot Window. From Plot Database, select the following two data items to draw 

them: 

▪ Force/PistonLubrication EHD 

Force/Lubrication1/AsperityContactForce/POSITIVE_X/FX_Asperity 

▪ Force/PistonLubrication EHD Force/Lubrication1/AsperityContactForce 

/NEGATIVE_X/FX_Asperity 

EHD Marker 

Positive X Negative X 

(-) Force (+) Force 

Positive X (-) Force 

Negative X (+) Force 
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▪ From the plot and contour results, you can check the contact point and the magnitude of 

the force over time. 

Checking Oil Film Thickness at Desired Points 

1. Go back to the Modeling Window, right-click Lubrication1 and select Property from 

the context menu. 

2. Click the Output Point for Clearance button in the Properties dialog window for 

Lubrication1. 

3. To check lubrication depths at the points 

shown in the figure to the right, set the 

Output Gap Point dialog window as follows: 

a. Enter Pistion.Marker1 in the 

Reference Marker field. 

b. Click the Add button several times to 

enter information as follows: 

1) Height: 14, Angle: 0 

2) Height: -14, Angle: 0 

3) Height: 14, Angle: 180 

4) Height: -14, Angle: 180 

c. Click the Close button to close 

the dialog window. 

 

 

 

4. To check the values, perform the analysis again. 

5. Click the Plot Result icon in the Plot group under the Analysis tab. 

6. From the Plot Window, click the Show Upper Windows icon in the Windows group 

under the Home tab. 
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7. In the window at the left, click the Load Animation icon in the Animation group under 

the Tool tab. In the window at the right, select the 4 data items under the Force/ 

PistonLubrication EHD Force/Lubrication1/MeasurePoints option in Plot 

Database to draw all of them. 
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Modifying Piston Profile and 

Analyzing Piston Lubrication 

Task Objectives 

In this chapter, you will learn how to analyze piston lubrication by changing the piston profile 

without modifying the previously defined RFlex model. 

 

Estimated Time to Complete This Task  

10 minutes 

  

Chapter 
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Modifying Piston Profile 

1. Right-click Lubrication1 and select Property in the context menu. 

2. Click the Profile button in the Piston group under the Properties dialog window for 

Lubrication1. 

3. When the Piston Profile dialog window appears, check the Use Profile option and 

enter values for the parameters to set the profile as follows: 

▪ Profile Length: 29 

▪ Number of Angle: 44 

▪ Reference Marker: Piston.Marker1 

▪ Number of Height: 19 

4. From the Piston Profile dialog window, click the Create Data Field Uniformly button 

and the data will be generated automatically for each angle and height. 

5. Click the Export button to export the generated data. 

▪ You cannot modify the data in the Piston Profile dialog window. Export the data 

to a file and use Excel or a text editor to modify the data in the file. 

6. Click the Import button to import the ProfileData.csv file provided in this tutorial. (File 

path: <Install Dir>\Help\Tutorial\Toolkit\EHD\PistonLubrication) 

7. Click the OK button in the Piston Profile dialog window to close it as well as to apply 

the data to the model. Click the OK button in the Properties dialog window for 

Lubrication1. 
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Analysis and Comparison 

1. Save the model as PistonLubricationEHD _RFlex2.rdyn. 

2. On the Analysis tab, in the Simulation Type group, click the Dyn/Kin icon. 

3. The Dynamic/Kinematic Analysis dialog window appears. 

4. After verifying the simulation conditions, click Simulation. 

 

5. Click the Plot Result icon in the Plot group under the Analysis tab. 

 

6. From the Plow Window, import the rplt file, which is the result of previous analysis. 

7. Right-click the Force/PistonLubrication EHD 

Force/Lubriation1/AsperityContactForce/NEGATIVE_X/FX_Asperity data from 

Plot Database and click Multi Draw from the context menu. 

▪ You will see that the result changes according to the piston profile. 

 

 

 

 

 

Thanks for participating in this tutorial! 

Profile 
Non-Profile 
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